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PC Interface Kit
Operating Instructions

Model No. K X-BPQO95
Electronic Print Board KX-BP0O95U
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® Before using the PC Interface Kit, please read these instructions completely.



Thank you for purchasing Panasonic’s KX-BP095,/BP095U PC Interface Kit.

This PC Interface Kit is an optional software product used to scan images from the KX-
BP735,/BP635,/BP535 series Electronic Print Board into a PC running Microsoft®
Windows® or Windows NT® and print documents on the PC to an Electronic Print Board
Printer.

In order to use the PC Interface Kit, you will need the KX-BP735,”/BP635, BP535 series
Electronic Print Board and an IBM® -PC, /AT or compatible machine.

Trademarks

® IBM® is a registered trademark of International Business Machines Corporation.
® Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft
Corporation in the United States and,”or other countries.

Windows® 3.1 is Microsoft® Windows® operating system Version 3.1.
Windows® 95 is Microsoft® Windows® 95 operating system.
Windows® 98 is Microsoft® Windows® 98 operating system.
Windows NT® means Microsoft® Windows NT® Workstation operating system or
Microsoft® Windows NT® Server network operating system.
Windows® 2000 means Microsoft® Windows® 2000 Professional operating system,
Microsoft® Windows® 2000 Server operating system or Microsoft® Windows® 2000
Advanced Server operating system.

® Accusoft is a trademark of Accusoft Corporation.

® All trademarks referred to in this manual are the property of their respective companies.

( Federal Communications Commission Requirements ]

(For United States only)

Note : This equipment has been tested and found to comply with the limits for a Class A digita! device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruc-
tion manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

FCC Warning : To assure continued FCC emission limit compliance, use only the the provided shielded inter-
face cable with ferrite cores when connecting this device to a computer.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.
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Notes

® Bitmap is an image file format of Microsoft Corporation.

® TIFF is an image file format of Aldus Corporation and Microsoft Corporation.

® Portions of this product are copyrighted by Microsoft Corporation and Accusoft
Corporation. '

® The information in this manual is subject to change without notification and does not pre-
sent a commitment on the part of Matsushita Electric Industrial Co., Ltd. or its operating
companies.

@ The software described in this manual is furnished under a license agreement and may not
be copied or reproduced without the express written consent of the manufacturer.

® The product should be used only with the cable that is supplied by the manufacturer.

® Other than for back-up purposes, neither this manual nor this software may be copied, in
whole or in part, without the express written consent of the manufacturer.

Warning about saving memory data
When this system’'s memory device or any of its optional memory devices is adversely effected by opera-
tional errors, static electricity, electrical noise, vibration, dust or when the power has been cut off due to
malfunction, repair or inadvertently, the memory contents may be lost or changed. Before operating the
system, make a point of reading the precautionary notes in this Operating Instructions and observe them
during operation.
Please observe carefully the following precaution:

® Make absolutely sure that all important data are saved by back-up or the original is saved.

The manufacturer hereby declares that it cannot be held accountable for any loss or change in any data
stored on floppy disks, hard disks, optical disks, or other memory devices.

Information in this manual is subject to change without notice.




To connect the Interface Board

1 Turn off the power switch of the Electronic Print Board, and unplug the power cord
from it. K

2 Remove the two screws and the option cover.
® The removed screws will be re-used in step 3.
® The option cover should be saved just in case the Interface Board is removed. to cover the opening.

T ------- -—(r ScreW

—I— Option
cover

3 Insert the PC Interface Board into the upper and lower board guides.

o =° Screw
PC Interface
Board

#* Insert the PC Interface

Board so that the fix-
ture on the board fits

inside the rear cover.
Rear cover

Insert the PC Interface
Board into the upper and
lower board guides.

Board guides



Before Using the Software

1-1.

1-2.

1-3.

1-4.

1-5.

What is the PC Interface?

PC Interface provides the following functions:

® The screen feed and copy functions of the KX-BP735,/BP635,/BP535
series Electronic Print Board can be operated from the PC.

® It scans, displays and saves (in the BMP or TIFF file format) the images which
have been written on the screen of the KX-BP735,/BP635,”BP535 series
Electronic Print Board.

® It opens (in the BMP or TIFF file format) and displays the images which have
been saved.

@ It displays the images in magnified or reduced sizes, and rotates the image display.

@ It displays the next and previous pages and any page from the page catalog list.

® It prints the images which have been saved.

What is the TWAIN Driver?

TWAIN Driver provides the following functions:
® It makes it possible to scan the images which have been written on the screen of
the KX-BP735,BP635,”BP535 series Electronic Print Board from an application
that supports TWAIN.

What is the Printer Driver?
Printer Driver provides the following functions:
® It is possible to print to the KX-BP735,/BP635,/BP535 series Electronic Print
Board from an application software being used on the computer.

Confirming Parts

Please confirm that you have all of the items listed below.
B PC Interface Board ... 1
B PC Interface Software floppy disks ... 3
® For Windows 3.1 ... 1
® For Windows 95,798 /NT 3.51,/NT 4.0,72000 ... 2
B TWAIN Driver floppy disk for Windows 95,798, NT 4.0,72000 ... 1
B Printer Driver floppy disk for Windows 95,798 /NT 4.0,72000 ... 1
B Interface Cable ... 1
B Operating Instructions ... 1 :
B Installation Manual (KX-BP0O95U only) ... 1
M Software License Agreement ... 1
M Registration Card {KX-BP095 only) ... 1
Please contact your place of purchase if you find that you are missing any of these
items.

System Configuration

@® A computer with the following system environment is required to run the PC
Interface Software.

Computer: IBM-PC_~ AT or compatible machine with a 3.6” 1.44MB
floppy disk drive
Software: DOS 5.0 (or higher) and Windows 3.1x
or Windows 95, Windows 98
or Windows NT 3.51 with Service Pack 5 (or higher)
or Windows NT 4.0
or Windows 2000
Memory: At least 2MB free memory
Hard disk: At least 2MB free memory
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® A computer with the following system environment is required to run the TWAIN
Driver or the Printer Driver.

Computer: IBM-PC /AT or compatible machine with a 3.5" 1.44MB
floppy disk drive

Software: Windows 95, Windows 98
or Windows NT 4.0
or Windows 2000

Memory: At least 1MB free memory

Hard disk: At least 1TMB free memory

Verify that all system components are connected and that the system is in proper
working order.

1-6. Connecting to the PC

Be sure to turn off the Electronic Print Board and PC before you connect or take off the
Interface Cable.

(1) Installing the PC Interface Board
For details, see “To connect the Interface Board” on page 4.

(2) Connecting the supplied Interface Cable
Connect the 36-pin Centronics interface cable connector to the PC Interface
Board and the other 25-pin D-Sub connector to the computer’'s printer port.

36-pin side } LL

» PC Interface
Board

/-

25-pin side

To the PC Interface Cable

Note: @ This is a propnetary PC Interface Cable for connecting the Electronic Print
Board with a PC.
Be sure to always use the supplied cable. Never use it with any other
products.

1-7. Installing the PC Interface Software

The setup program provided by the PC Interface Software performs all the tasks nec-
essary for installing the PC Interface Software components. You can install everything
at once.

(1) Start up Windows.
® Logon as the administrator when using Windows NT 3.51,/NT 4.0,72000.

(2) Insert the program floppy disk into the floppy disk drive.
® For Windows 3.1 - insert the floppy disk labeled (for Windows 3.1).
® For Windows 95,798,/NT 3.51,”NT 4.0,72000 - insert the first floppy disk labeled {for
Windows 95,798,/NT, 2000 DISK #1,72).
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1-8.

(3) For Windows 3.1,/NT 3.51,
Click{ File ]in the Program Manager, and click| Run |on the File menu.
For Windows 95,798 /NT 4.0,/2000.

Click the[ Start {button, and click| Run |on the Task Bar menu.

(4) Type “AN\SETUP” in the Command Line text box, and click.
® For KX-BP095LJ - click the language button to select the language.

(5) Input the drive and path name where the PC Interface will be installed or press

to select “C:\\BPx35PC" which is the default.

@ To quit setup, click .

® For Windows 95,798, /NT 3.51,/NT 4.0,72000 - replace the second floppy disk labeled
{for Windows 95,798,”NT,”2000 DISK # 2,72) according to the instructions on the screen.

[For Windows 3.1,/NT 3.561]
When the installation of the PC Interface is completed, the group for the
Panaboard BPx35 PC-Interface will be displayed in the Program Manager, and the
PC Interface icon will appear in this group.

[For Windows 95,798 /NT 4.0,72000] .
When the installation of the PC Interface is completed, the group for the
Panaboard BPx35 PC-Interface will be entered in the Program menu.

Note: ® For Windows NT 3.51 - it is necessary to install “Service Pack 5" or higher.
You are able to download “Service Pack 5" for Windows NT 3.51 from the
Microsoft Corporation Home Page of the Internet.

® For Windows NT 3.51,/NT 4.0,/2000 - restart the computer before using
the PC Interface Software.

B Uninstalling the PC Interface Software
® For Windows 3.1 - there is not an uninstaller utility. Please delete the directory
where the PC Interface was installed and the group for Panaboard BPx35 PC-
Interface in the Program Manager.
® For Windows NT 3.b61 - double-click the Uninstaller icon within the Panaboard
BPx35 PC-Interface Program Group.
® For Windows 95,798, /NT4.0,/2000 - click the [Start |button, and then click

|Panaboard BPx35 PC-Interface Uninstaller |in Panaboard BPx35 PC-Interface
under Programs.

Installing the TWAIN Driver

To scan the images which have been written on the screen of the KX-
BP735,/BP635,”BP535 series Electronic Print Board using a TWAIN compliance ap-
plication software, it is necessary to install the contents of the included floppy disk
onto the PC.

(1) Start up Windows.
@ Logon as the administrator when using Windows NT 4.0,72000,

(2) Insert the TWAIN Driver floppy desk into the floppy disk drive.
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(3} Click the button, and cIick on the Task Bar menu.

(4) Type “"A:\SETUP" in the Command Line text box, and click| OK |.

Note: For Windows NT .4.0,72000 - restart the computer before using the TWAIN
Driver. '

B Uninstalling the TWAIN Driver

Click the| Start |button, and then click| Control Panel Junder Settings. Double-click

the “Add,/Remove Programs” icon, select “Panaboard Bx30,”BPx35 TWAIN
Driver” which has been registered, and click the| Add /Remov |button.

1-9. Installing the Printer Driver

To print to the KX-BP735,"BP635,”BP535 series Electronic Print Board printer, it is
necessary to install the contents of the included floppy disk onto the PC.

(1) Start up Windows.
® Logon as the administrator when using Windows NT 4.0,2000.

(2) Click the| Start |button.
(3) Click on| Settings [and then click| Printers |on the Task Bar menu.

(4) When the "Printers” window appears, double click on the "Add Printer” icon.

(6) Follow the on-screen instructions when the “Add Printer Wizard” executes.
® When the screen for selecting manufacturer and printer appears, insert the Printer
Driver floppy disk into the floppy disk drive, and click the| Have Disk |button.
When the screan for installing from disk appears, enter the following in
“Copy manufacturer’s files from”, and click.

- Windows 95,798, English, Paper size A4 +--rreseeeeee “A:\ English™\Win95-98\ A4”
+ Windows 95,798, English, Paper size Letter-----+----- “ANEnglish™\\Win95-98\ Letter"
« Windows 95,798, German, Paper size Ad «rrrerieerees AN German\ \Win95-98”

» Windows NT 4.0,72000, English, Paper size A4 -+ “ANEnglish \\WIinNT-2000\ A4”"
» Windows NT 4.0,/2000, English, Paper size Letter---*A\English\WIinNT-2000"\ Letter”
« Windows NT 4.0,72000, German, Paper size A4+ “ANGerman ™\ WinNT-2000"

Note: @ When using Windows 95 or Windows 98, a floppy disk or CD-ROM for in-
stalling the operating system will also be necessary. (See page 9.)
® When the printer driver installation is completed, the printer having the
printer name set in the printer window will be added.
The default printer name is “Panaboard BPx35 Printer”.

W Deleting the Printer Driver
Click on the printer set during installation in the “Printers” window, then click

 Delete |on the File menu.
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B Special Note for Windows 95,798
if your PC had Windows 95,798 pre-installed and the original Windows 95,798 CD-ROM
or diskettes were not included. In this situation, please try to locate the necessary files by
following the methods described below or refer to your PC's User's Guide for more de-
tails.

® Method-1: Specify the Windows 95,798 backup file location in the hard disk of your
PC.

Generally, the Windows 95,798 backup files are located in the

“WINDOWS\ OPTIONS\CABS" folder. Type " C:\WINDOWS\ OPTIONS\ CABS”
in the | Copy_ files from | box on the | Copying Files | dialog box, where “C:" is your
Windows 95,98 boot drive and then click the OK ] button.

If the necessary files are found, the installation will proceed.

Otherwise, click thebutton, a dialog box appears as shown below including

the cabinet file name ( *.cab listed under the Description File} that contains the
necessary file.

Emor Details [ %]
i'i The follewing error ceeuned: The fle was not found' (eror #2]
-

Setup coutd not linish cpening & file on the source disk,

Source file: '&\ENGLISH\WINSS-38\LETTERACONLIB,DLL'
Destination file: 'C:\WINDOWSVSYSTEMAICENLIB. DLL=win95_15.cab’

In this example, the cabinet file name is “win95__15.cab”. (Note that the cabinet file
name may vary depending on your PC.)

To search for the file in your PC

(1) Click the[ Start [button on the Task Bar and then click on| Find |.

(2) A dialog box appears prompting for a file name to be searched, type
"WIN95__%.CAB” or “WIN98__% .CAB" in the| Name |box, type “C:\\" in the

box and check the box for| Include subfolder |.
(3) Click the| Find Now ] button. When the cabinet file is found, make a note of the
folder name where the file is located.

(4) Return to the| Copying Files | dialog box and type the folder name in the
|Copy files from |b0x. For example, type "CN\WINDOWSN OPTIONS\ CABS" .

Then click the| OK ] button.

® Method-2: Create the Windows 95,798 backup diskettes and then specify the
diskettes.

Depending on the PC, there is usually a tool from the manufacturer to create the
Windows 95,798 backup diskettes in a Windows 95,798 pre-installed system. Please
refer to your PC’s User's Guide for more details on this tool.

Create the Windows 95,798 backup diskettes by using this tool, and then install the
Printer Driver by following the procedures from Step (1).
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2-1. Initial Screen

The screen shown below appears when the PC Interface Software is activated.

. — e et n— e .

Menu Bar ——
Tool Bar ’

Work Space —-{
|

Status Bar ——[[Conboithe Panaboard, Stanthe image from the Panaboard.

5 I Panaboard BPx35 PC-intertaca - Untitted M=
fie View Hep

OB Qaa QR ~i» ][ zomoxoest ||

hi
T

Menu Bar:
Tool Bar:

—

Provides available menus within the PC Interface Software.
Contains the buttons for performing the same operations as on
the menus, the page number of the image now displayed, display
magnification and display angle. For a more detailed description,
see pages 10 to 11.

DletlEl w8 [ @[ali3| e [paser 4| ]|[ zoom25% Deo

Work Space: Displays the images which have been scanned or opened or dialog

Status Bar:

boxes.
Disptays the operating condition of the PC Interface Software.

2-2. Menu Configuration

The following menus can be used with the PC Interface Software.
With menus providing pictures of buttons, the same operations can be performed sim-
ply by clicking the buttons on the Tool Bar.

Save As:
Lo Panaboard
Control:.

‘& Print:

" Preferences:

Exit:

1 Actual Size:

¥3 Fit Window:

[@ Zoom In
[125%]:

To clear the image displayed or to create a new image file.

To open an image file.

To save the image displayed.

To save the image displayed changing the file name and type.
To operate the Electronic Print Board and scan the image from
the Electronic Print Board.

To print the images displayed.
To set the PC Interface Software environment.
To exit the PC Interface Software.

To display images in their actual size.

To display the whole image so that it fits the size of the win-
dow.

To magnify the image displayed. [ 125%] displays the current
magnified rate which can be varied in “Preferences”.
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Q! Zoom Out
[80%]- ‘
I} Rotate 90:

[iw]n]
Qg

Catalog:

i 4] Previous Page:
[»] Next Page:

Contents:
About:

To reduce the image displayed. [80%] displays the current re-

duction rate which can be varied in “Preferences”.

To rotate the displayed image clockwise in 90-degree incre-

ments.

To display the pages in the form of a catalog.

When displaying the page(s) in the form of a catalog, the “v "

mark will appear on the View menu next to “Catalog”.

I (Page): In order to display in the form of a page, select
“Catalog” again to make the “v " mark disappear.

[Paser =] (Select Page): To display the selected page.

To display the previous page.

To display the next page.

To display help information.
To display information about the PC Interface Software.

11
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2-3. Panaboard Control Dialog Box

When “Panaboard Control” is selected on the File menu, the Panaboard Control dialog
box appears. The following details are displayed in this box.

(KX-BP735)

{KX-BP635,/BP535)

Fanaboard Control

1. ‘ﬁ

)

Panaboard Cantrol

. Standby.. _ _. 1 Page:n |

: Status: | B
' " cancel |
Status: Displays the PC Interface status.

—Standby: Indicates that the Electronic Print Board is in standby mode, the
Electronic Print Board can be operated from the board itself and from
the PC Interface Software.

—Rotating: Indicates that the Electronic Print Board is rotating the screen.

—Copying: Indicates that the Electronic Print Board is copying the screen.

—Scanning: Indicates that the Electronic Print Board is now scanning the screen.

—Receiving: Indicates that scanned images are being transferred from the
Electronic Print Board to the computer.

A bar is used to indicate progress status.

—Converting: Indicates that the image data is being converted so that the computer
will be able to display the scanned data.

—Busy: Indicates that the Electronic Print Board is busy.

—Error: Indicates that an error has occurred with the Electronic Print Board.

—Power Off: Indicates that the Electronic Print Board is turned off.

Page: Displays the number of scanned image pages.

Cancel “OK: Click to close the Panaboard Control dialog box.

® This functions as before a single page has been scanned.

® This functions changes to when the page has been scanned.

@ This functions as the during Electronic Print Board scanning or image data
transfer. When is clicked during Electronic Print Board scanning or image

data transfer, the page being scanned is canceled and scanning is suspended.
The images scanned until that point remain valid.
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B About the Control Panel
It is possible to perform the same operations as with the Electronic Print Board control
panel from the following Panaboard Control buttons.

Note: While the Panaboard Control dialog box is displayed, the copy key and 2-screen
copy key on the Electronic Print Board control panel are used for scanning images

into the PC.
Name Panel Description
When displayed, this indicator shows the contrast during
scanning or copying and indicates when the thermal transfer
film should be replaced.
@ Contrast/ - Ind!cator off_: Normal scanning or copying contrast.-
R .. = Indicator on: Darker than normal scanning or copying
emaining =
Film € . . contrast.
. i Indicator flashing: Almost time to replace the thermal transfer
Indicator film
{Note that only about 15 more copies
may be made when this indicator starts
flashing.)
(@ Contrast O Each time this button is pressed, the unit will alternate be-
Button tween normal and dark contrast modes (Normal / Dark).
(3 2-Screen E For the KX-BP535 and KX-BP635 only:
Scan Button ® This button causes both screens to be scanned in a single page.
@ gcan 7Y This button causes the screen to be scanned.
utton @
(KX-BP735)
This indicator displays the number of copies to be made. The
display changes each time the multi-copy/stop button is
pressed.
: For the KX-BP535 and KX-BP635:
(5 Multi-Copy ‘ Example: 1/ 2 —> - =9 = 1 — ...
/Error For the KX-BP735:
Indicator Example: 1 =2 —= - =9 =/ =1 — ..
“/!" is used by the KX-BP735 to indicate 4-screen continu-
ous scanning or copying.)
When an error occurs, a flashing symbol will appear in this dis-
play to indicate the error status.
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Name Panel Description
When making multiple copies, press this button until the de-
sired number of copies is displayed on the multi-copy,/error
i indicator. This button can also be pressed while multipie cop-
® Multi-Copy il ies are being made to stop the copying process.

/Stop )¢ | For the KX-BP735 only:

Button ® For 4-screen continuous scanning or copying, keep pressing the key
until “/{ " appears in the multi-copy“error indicator. Also press the
button to stop 4-screen continuous scanning or copying at any time.

® During scanning, the setting 1 to 9 for the number of copies is ignored.
This button advances the screen from right to left.
@ Advance <] | For the KX-BP735 only:

Button ® Pressing this button twice will cause the screen to advance two

screens from right to left.
For the KX-BP735 only:
Reverse [> ® This button advances the screen from left to right.

Button ® Pressing this button twice will cause the screen to advance two
screens from left to right.

@ 2-Screen Rg| For the KX-BP535 and KX-BP635 only:

Copy Button ® This button causes both screens to be copied on a single sheet of
paper.

Copy T This button causes the screen to be copied.

Button

(KX-BP735)

3% See the operating instructions provided with the Electronic Print Board for the specific
operating procedures.
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3-1. Startup

(1) Turn on the power of the Electronic Print Board.
(2) Turn on the computer's power and start up Windows.

(3) For Windows 3.1,/NT 3.51, double-click the Panaboard BPx35 PC-Interface
Program Group, then double-click the Panaboard PC Interface icon within the
group.

For Windows 95,798,/NT 4.0,72000, click the button, and then click

[Panaboard BPx35 PC-Interface | in Panaboard BPx35 PC-Interface under
Programs.

(4) The PC Interface Software’s initial screen now appears on the computer
screen.

. Electronic Print Board Scanning

(1) Check whether or not the multi-copy,/error indicator for the Electronic Print Board
is “1” through “9" or “!!{" (KX-BP735 only).

(2) Click EJ on the Tool Bar.

(3) The Panaboard Control dialog box now appears. Check that it is in the “Standby”
status.

® The Panaboard Control dialog box will not appear when the Electronic Print Board is not
ready.

(4) Click @ or [m8| (KX-BP635,/BP535 only) in the Panaboard Control dialog
box.

® It is also possible to start scanning in image data using the copy key or 2-screen copy key
{KX-BP635,”BP535 only) on the Electronic Print Board control panel.

(6) The status of the Panaboard Control dialog box now changes to “Scanning” and
the Electronic Print Board starts scanning.

(6) Then, the status of the Panaboard Control dialog box changes to “Receiving” and
transfer of the image data from the Electronic Print Board to the computer now
commences. :

® While the image data is transferred, the Progress bar appears to indicate the progress made
in the transfer of the image data.

® The Electronic Print Board’s multi-copy.” error indicator flashes while the image data is being
transferred from the Electronic Print Board to the computer.

{7) On completion of the image data transfer, the status of the Panaboard Control dia-
log box changes to “Converting”. The pages are then counted, and the scanned im-
ages are displayed on the screen. If the display is completed normally, operation
returns to step (3), and the status of the Panaboard Control dialog box changes
to “Standby”.

(8) To scan data again, repeat the procedure outlined above from step (4).

15
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3-3.

(9) To exit scanning, clickbutton in the Panaboard Control dialog box.

® When set to Auto Save Mode, the Save As dialog box will appear automatically if there is not
an active file displayed with filename, then the file should be saved. (For further detaiis about
saving image files, see 3-3.)

Note: ® When a new image file is to be created, click “New” on the File menu before

scanning, and create the new file.

® While scanning, please do not drag the Panaboard Control dialog box as this
may interfere with the scanning process.

® While scanning, please do not operate any other application software as this
may interfere with the scanning process.

® The keys on the Electronic Print Board will not operate until the multi-
copy ./ error indicator display changes to “ ;' “ after scanning.

soen T me
Saving Image Files | sovere  [Eope 7 o of il
Sample01
. 7] arctes2 ;
(1} Click on the Tool Bar. r E""."?.f
® BMP File - can only contain 1 Scanned Image. " !
(1 Page) |
® TIFF File - can contain multiple Scanned Images. (- —— l e
® When saving the Scanned image to the active O - e
image displayed and already named, L e e -

For {BMP) - Scanned images are added with the same filename as the one displayed and
{01-99) is added sequentially to the end of that name. (Separate Files)
The Save As dialog box will not appear.
For (TIFF) - Scanned images are added to the image file now displayed. { Multi-page TIFF: 99
pages maximum) The Save As dialog box will not appear.
(2) The Save As dialog box now appears. Set the file format, folder in which the file
is to be saved, and the filename.
® When saving the scanned image to the selected image, the image will be added to that file.
The Save As dialog box will not appear.
® For BMP Files, add the extension “.BMP" to the filename.
For Windows 3.1 - because the last two characters of the eight-character filename are used
for the page number, only the first six characters can be used for the filename.
For Windows 95,798,”NT 3.61,/NT 4.0,72000 - the long filename can be used.
® For TIFF Files, add the extension “.TIF" to the filename.
For Windows 3.1 - the filename is up to eight characters.
For Windows 95,/98,”NT 3.51,/NT 4.0,/2000 - the long filename can be used.

(3) Click| Save |.

Note: ® For BMP or Uncompressed TIFF File Format, the file size per one page is
about 420KB. Therefore you may save about 3 pages in 1.44MB floppy disk.
® In order to use the image file in another application software, it is required
that the image file be saved in a file format which is suitable for that
application software.
® The saved image file is a monochrome image.

Select TIFF File Format

= TIFF File Format—————=——

When the TIFF File is selected:

(4) The TIFF File Compression dialog box now
appears.
When it is not necessary to compress, click

ITIFF:Uncompression |.
To compress, click| TIFF:G4 Compression |. | E—r———————




PC Interface Operation

3-4. Opening Image Files
(1) Click C2 on the Tool Bar. -

==
(2) The Open dialog box now appears. Set the K — 1]
file format, folder in which the file is saved, | g SRR
. 1 Samplel!, bmg |
and the filename. gz |
After opening the image file, another page | [Bsmwoiime i
can also be displayed by selecting the [ - g
Previous,”Next Page on the View menu. P r—— T
]FI o bpa. [BMP Fio (BMPLTFF Fie (L TIF] = careot

(3) Click [ Open .

Note: When the page number for BMP file(s) is not sequentially numbered from “01”,
the file name i1s changed and the pages are restructured automatically.

3-5. Printing Images T'W_EE'
(1) Open the image file. | e Fcommmm 5] T zeein |
L Type: ‘ P::ehnard BP=35 Printer
(2) Click & on the Tool Bar. 7; x.m
(3) The Print dialog box now appears. SR Mt tzooes [ |
e T || CHERCE e
! m L _Geredl |
Printer: The current printer selection appears.
Print range: To designate the range of pages for printing.
All: To print all the pages of the displayed image file.
Pages: To print the desired pages of the displayed image file.

Selection: To print only the displayed page.
Number of
copies: To designate the number of copies.
Collate: When this is selected, it prints in page order.

(4) Click[ OK].
® Clickto stop printing.
® if you click, the Printer Setup dialog box appears.

The contents of the Printer Setup dialog box varies with different printers.
Refer to the manual of the printer.

Note: Be sure to turn off the Electronic Print Board and PC before you remove the
proprietary PC Interface Cable and reconnect the PC’s Printer Cable.
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PC Interface Operation

3-6. Preferences .
This sets the environment. _9 W [25 = ouw [0 [ =l

The figure shown here displays = Foing: Aats Save wods
the default settings. i Gancel |

B Zoom Ratio

rCatalog Size—
B Y vk |

rErint e e
7 . FiPaper
F_Auio Rotate

This enables the magnifications for Zoom In (MIN : 100 [ % }JMAX : 200( % ] ) and

Zoom Out (MIN :

M Catalog Size

50( % —MAX: 100 % ] ) to be set.

This enables the horizontal ' vertical size {MIN : 100 ( Pixel J—MAX : It varies with dif-

ferent size of windows.) of the catalog to be set.

® When the catalog size is reduced, more pages can be displayed in catalog form at one
time but the images on those pages will be reduced in size, making it harder to see

them.

B Print
Fit paper:

Auto Rotate:

When this is selected, the image is printed out to fit the size of a paper
set on a printer.

When this is selected, the image automatically rotates to fit the direc-
tion of paper set in a printer. When selected, this will override the
printer drivers paper direction setting to fit image direction.

This can work only if Fit Paper is selected.

B Filing: Auto Save Mode
When this is selected, if there is not an active image with filename displayed, the Save As
dialog box will appear automatically after the Panaboard Control dialog box is closed so
that the New scanned image(s) can be saved.
When this is selected, if there is an active image with filename displayed, the Scanned
image(s) are automatically added with that filename (BMP-Separate Files) or to the ex-
isting file { TIFF-Multi-page). The Save As dialog box will not appear.

3-7. Exiting

(1) Click on the menu bar.

(2) Click| Exit |on the File menu.

Using the TWAIN Driver

Select "Panaboard Bx30,”BPx35 TWAIN Driver” when using the TWAIN driver installed
from the application which supports TWAIN and which you are using in your computer.
Normally, when "Select Source” is clicked from the file menu, a list of the TWAIN drivers that
can be used is shown so select one of the drivers displayed on the screen.

® The KX-BP73b's 4-screen continuous scanning function cannot be used if the TWAIN
driver is to be used.



Using the Printer Driver

When printing to the Electronic Print Board printer from an application software used on the
PC, select the print menu from within the application software and on the print dialog box
displayed, select the printer name set during installation.

The default printer name is “Panaboard BPx35 Printer”.

® The muliti-copy,”error indicator on the Electronic Print Board will flash during printing.
After printing begins, the Electronic Print Board keys do not function until the multi-
copy,/ error indicator is illuminated.

Note: @ Printing is not possible while the Panaboard Control dialog box of the PC Interface

Software (see P.12) is displayed.

@® This printer driver does not correspond to the “Pause Printing” command in the
Print Manager. Please do not execute “Pause Printing”.

® The maximum number of copies which may be printed is 9. Do not set this field
higher than 9. . ,

® The output tray of the Electronic Print Board can hold up to 20 sheets of printed
paper. (Paper jams may occur if 20 sheets are exceeded.)

® The print density cannot be controlled with the contrast key on the Electronic Print
Board control panel.

@ If printing data with a lot of black area, continuously printing irregular density
and,”or white streaks may appear on the output paper. In this case, please wait for
a while and re-print.

Hl For Windows NT 4.0
You will need to change the printer driver settings as described below in order to use the
printer driver under Windows NT 4.0 if you find it does not print after installation.

(1) Click on the Windows NT 4.0[ Start | button.

(2) Click on[ Settings |and then click [ Printers |on the Task Bar menu.

{3) The "Printers” window will appear. Double-click on the printer name that was set
during installation {(default: Panaboard BPx35 Printer).

(4) Click on| Purge Print Documents ]on the[ Printer |menu to delete all unprinted
documents.

(5) Click on/ Properties |on the[ Printer |menu.

(6) The “Printer Properties” window will appear. Click on/{ Print Processor |on the

tab,
{7) The “Print Processor” window will appear. Check “Always spool raw data” by clicking
~ onit, and then click| OK].
(8) Click on the[ Scheduling |tab of the “Printer Properties” window and click “Start

printing after last page is spooled”.
(9) Close the “Printer Properties” window by clicking on| OK |.
(10) Restart Windows NT.

Note: The above settings are enabled the next time Windows NT is started.
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